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ChimeRMarker Workflow

Lo-ad donor and »Rapid accurate allele and size calls
recipient samples » Automated detection of informative alleles

» Linked chimerism calculations and statistics
Run wizard . : :
» Audit trail and electronic record

Automated size
and allele Call

Select CHM Analysis
Application
Clinical Research
Report

Applications:

»Single Donor Analysis
»Double Donor Analysis

»Maternal Cell Contamination

Longitudinal
Report




Loading Data and

Specifying Identifiers

»Start Your Project:

»Open Data

— DLArt your pryject

= Open Data
Open Project »

<P Previous Next =

»Open Data Files:
»Add
»>Select Files
(CTRL+A)

Data File List:

CAUsershsoft\Desktop\Mock_chimerism_data‘\Donor SG1
C:A\Usershsoft\Desktopt\Mock_chimerism_data\Recipient SG1

Remove |
C:\Users\soft\Desktop\Mock_chime

Remaove Al I
Add Folder... I

Default

.EChannels...l 0K | Cancel |

View->Preference-> Chimerism

(Bmess " _ﬁ__—.

Start up Setings | Display Settings ~ Chimerism I Report Settings | Others |

[~ Show Ladder Samples in Report |~ Show Control Samples in Report Parameters
v Mark Deleted/E dited Peaks with Symbols Donor&Recipient List: Designation: -
—Jv Label Peak Ratio Recipient Pat (3
@ LabelPeak Height Ratio (" Label Peak Area Ratio Donort don
Donor2
~Chimerism Donor3

Ladder |dentifier: ILADDEH Maternal: IM_ Donord il
F

Positive Control Identifier: I-PIZ- Fetus: Sample Origi: Designation:
-N

Negative Control |dentifier: I C- Tissue2

Donor/Recipient/Tissue Type Sellings ﬁ I?ssuei
‘ issue

Tissue5

>

Tissuel 3

I ~Data Store

User Name: Ilims Password: l‘“‘““_ Tissue >
*specify identifiers for

T donors, recipient and sample

e origin

See ChimerMarker Manual
Chapter 2



kations

Tools Help

v @

7’

[@] Urtited

=6 RawData

V Mix: 821_D02_08 fsa
 Mix: 866_H09_15.fsa
Mix: 933_E01_09fsa
Mix: 959_F05_11.fsa
R: pat.fsa

Raw Data Screen

1%

Gel Image

821_D02_08fsa

2,000

12,000

10,000
\ 8,000
6,000
4,000

2,000
0

66_H03_15.fsa
2,000

3,000 5,000 6,000 7,000 8,000 9,000 10,000 11,000

VIR PO I D A | K U S A S AU N
PageUp  PageDown . .
New 6 samples PC error: 0/0 NC error: 0/0 Ladder error: 0/0 #Failed=0 #Flagged=0

See ChimerMarker Manual
Chapter 3



Size & Allele Calls using
Run Wizard

»Click on Run Icon to begin [l 2 |

Run Wizard Template Selection:

*Select the appropriate Panel and Size Standard
from Drop Down Menu.

Run Wizard

Template Selection
Set the template of the project

(% Select an existing template or create one

4 Identifiler
M Identifiler_MCC
M PowerPlex_16_ILS500

Template Name: IPowerPIexJ 6_ILSE00
Panel: IPowevPIex_1B 'I uLIﬂ

: Please calibrate panels to

BN Your instrument before proceeding. Refer to

*Slide 7 or *Chapter 6 in User Manual or
contact *Tech_Support@softgenetics.com

ElPowerPlex_16_1L.S600 SkeStandard: [Is60 -] Il
4 PowerPlex_ESI_17
N400 : [Red |
A Profiler_HD400 SeriiiEs |l
A Profiler_Plus_HD400 arabsisType: [Cimein 2]
4 SGM_Plus
" Use last template [ Save | X Delete |

Run Wizard

Data Process - Chimerism Analysis

Set data process options

<< Back

I Nexst >> I

LCancel |

Page 1

W Auto Range (frame) N
sat[l 2] End [f20 3]

v Smooth [ Enhanced Smooth

[V Peak Satuation [v' Baseline Sublraction
[~ Enhanced Baseline Subraction
WV Spike Removal

WV Pullup Conection

Size Call
 Local Southem " Cubic Spline
Load Default | Save Default

[~ Al Call
[ Auto Range (bps)
Statt lﬂ End: ,ﬂ
Peak Detection Thieshold:
Mmlmznsily,m Max Intensity: (000 %1
Pememgw,ﬂ Global Max

[~ |Please Enter Grouping File Path ﬂ

[V Only Call Allele Presentin CHM Panel

[V Auto Create CHM Panel «

Chimerism Sample Indetification

CHM Panel Name: |Chimer_DK_Profilerpl

No.] Type| SanpleName [+
R pat
D1 don
03761113
061_£08_10
3B4E06_10

Additional Settings:

*Select Auto Select Best Ladder and Auto
Panel Adjustment

Additional Settings - HID Analysis

Set additional options related to the different analysis type

Allic Ladder: | NONE |
[V Auto Select Best Ladder
Positive Control Template: | NONE v
Alcle Evaluatior [V Auto Panel Adjustment
Peak Score:

Reject < [1.00 Check [1.00

< Pass

<< Back | LCancel

1
2
3
4
5
§ S
7
8
9
1
1

0 886_HO9_15
1

=]

Page 3

»>Select “Auto Create CHM Panel” to have ChimerMarker
automatically create a Chimertyping panel and apply it.
» Deselect to manually create Chimertyping panel

See ChimerMarker Manual
Chapter 2 and 3



Review Size and Allele Cells

C 001Dd
Size Called Sampl 2 ¢ C eport Jap e
K ChimerMarker - 2
Green=High Lane Quality FleVom P gt Tk~
- . oo . £y . " /@ =
Yellow=Requires Verification :‘ ) WEE s ® QEQ Bl o . | E
. . (@] ist_616:2011.56C ' Report Y H Bin 9
Red_Slze Dld NOt Occur gz&%ﬁ (037 6113652 R RS Sample perker [rllelefplieledplleled]
| 081179 I D21S1 ][ oesst ] Py fosc.ges = X v
102 ] 20 140 160 . 18'0. 0 20 "240 % 280 3{0 o oo | 16 |
- Mic 037 6T1_136a a00f " ) | % Jar.tee hes @ 2 @
B Mic 061_E08_10sa L. T Vs e |l
- Mic 384ED6 101ss i Denotes Donor, Recipient and Shared
B M 42_F11_Thsa . S oo 50 pe ¢ @ Y
- Mix 556_E01_09fsa 1,600- Alleles in Post BMT samples 6 [don.fsa pesii7s | 16 @ 19
-@ Mix 793 G10_14fsa 7 |don.fsa n21511 | 32 @ 3¢ @ 35
~[ Mix 821.D02_08fsa 1,400 [orR] 8 |don.fsa Diesst | 14 @ 15
B Mix 866_H09_15sa
7B Mix 933_E0_09hsa 120 DR [orR] C e CRELE
) Vi 35811 5 10 |037_G11 13.fsa [D8s1173 |f 16 fF 13
) Wik 333 £06 10fca 1,000 i 11 [037_G11 13.fsa [p21511 |ff 32 @ 3¢ @ 35
Electropherogra NS - N 12 [037_G11 13.£sa [p12ssi |@ 1¢ @ 15
80 13 [061_E08_10.£sa [MEL “
&0 14 |061 E08 10.fsa [Des1175 |ff 16 fF 13
15 |061_E08_10.fsa [D21511 |ff 3¢ fF 35
400 16 061 E08_10.fsa |p18ss1 (@ 14 M 15
200

17 384 206 10.fsa [nEL (@ x @ ¥
18 |384_E06_10.fsa [D8s1173 |ff 16 fF 13
LW 19 [384 506 10.£sa 2511 | @ 32 @ 3¢ @

0

Peak ( hart/ Table 20 [384 E06_10.£s2 |55t | 14 @ 15
W u M wu 1A 21 (432 F11 11.fsa 2L (@ x @ ¥
@ @@ E@ 22 |432_F11 _11.fsa (0851173 (ff 16 M 19
M Dye | Size | Height | &rea Marker Mlele | Qualty | Score | Comments QualtyRea. | 23 [432_F11 11.fsa [D21511 | 3¢ @ 35
Green 1024 1835 14971 AMEL X Pass 1970 24 |432_F11 11.fsa [D18351 | 14 fF 15

Green 1085 1590 12244 AMEL Y Pass 1377
Geen 1836 100 GM8  DESIE 16 Pas 127 2 peaiol09.fe or X @ ¢
Gieen 1822 %1 7012 DGSH73 19 Pas 992 26 [558_201 0.5 |oesiirs | 16 fff 13
Green 2232 143 1484 D21t R Pass 12 27 [s58_E01_09.fsa [D21511 (ff 3¢ | 35

Geen 2315 100 1077 DS M Pass 455
Geen 257 9% 1400 DASH B Pas 449 20 ETEINUSReRy IR Y ¢ | i
Gieen 285 1314 10 DISL 1 Pas 1006 2 [1s3ct0 14602 [l | x @ ¥
Green 3006 842 7953 D18SE 15 Pass 496 30 [793_G10_14.£sa [Des1175 (@ 16 M@ 19

©°

© o~ O 1 o o —



Panel Editor

*Tools > Panel Editor=> Select Panel of Interest under “Panel Template”

File Tools Help

*If one or more allele is

D EHB X

LA D Hp |

? PowerPlex_ESI_16_v1_ »
B[4 PowerPles_ESI_17_v1_
{4 PowerPlex_ESX_16_v1
{4 PowerPles_ESX_17_v1

&[4 Profiler

@[ Profiler_1

B[4 Profiler MCC
#-{# Profiler_Plus
&-{# Profiler_Plus_1
&[4 Profiler_Plus_MCC
B[4 SGM_Plus
#-[# SGM_Plus_1
#-[# SGM_Plus_MCC
&[4 Profiler_Kiistt
#-[# Chimertyping Panel

®-[#& DoubleDanarChimertypit
S

Rl —)

»

5,000

4,000

3,000

2,000

E-& Samples

@ patfsa

-~ donfsa

g 037_G11_13fsa
- 0B1_E08_10.fsa
- 384_E0B_10fsa
o 432 F11 11 ksa
g 558_E01_09sa
) 793 G10_14fsa
-~ 821_D02_08fsa
- 866_H09_155a
g 933E01_09fsa
-~ 959 F05_11.fsa
Q) 333.E06_10fsa

Profiler

not aligned correctly to its
| - = bin:

*Adjust and calibrate
panel
*Hold Shift key +
Left-mouse click on
Marker Label or Bin

[12 13 [14] 15 16| [17] 18 19 .

No. | Dye Marker Size Left Range| Right Range Control | Distance/kb | Comments g and drag 1t ]-eft Or
1 |Blue  D351358 109 15 15 12 1 0.00 Ni : : :
2 |Bue  D351358 150 15 15 13 1 0.00 Nil I'lght to ahgn 1t to the
3 |Bue  D351358 190 15 15 14 1 0.00 Nl
4 |Bue  D351358 1229 15 15 15 1 0.00 Ni alleles.
5 |Blue | D351358 1271 15 15 16 1 0.00 Nil
6 |Bue  D351358 1314 15 15 17 1 0.00 Nil
7 |Bue  D351358 1355 15 15 18 1 0.00 Nil
8 |Blue  D351358 1396 15 15 19 1 0.00 Nl a :
9 |Blue  vwA 1543 15 15 11 1 0.00 Ni AdJUSt marker
10 |Blue | vwA 1585 15 15 12 1 0.00 Nil .
Tlehe i w27 15 15 1 1 o Ni parameters-> Filter out
12 |Blue | vwA 1669 15 15 14 1 0.00 Ni :
13 |Blue | vwaA 1708 15 15 15 1 0.00 Nl noise
T4 |Blue | vwA 1749 15 15 16 1 0.00 Nil
<[4 »

[Panel Name]: Profiler

[Ploidy]: 10

See ChimerMarker Manual
Chapter 6



Navigation

Zo0m in:

-In electropherogram, hold left mouse click and
drag a box from upper left to lower right

Zoom Out:

-In electropherogram, hold left mouse click and
drag a box from lower right to upper left.

Scroll:

-In electropherogram, hold right mouse click and
drag trace left or right.

One Color Viewing
-Click the Show Color Icon a8 v

Hide Option:
-Click the Show/Hide Icons @ @ @‘

remove flie list, gel image, report table

ReciierkS61 152712876 %

| D% || THot || oSt |
150 0

See ChimerMarker Manual
Chapter 4



Making a Chimerism Panel

If you selected “Auto Create CHM Panel” in the Run

Wizard dialog, skip this step and move onto page 10

Specified
Unique Panel
Name

File Tools Help

lﬁbluu E-a-[e|ST

Panels Testl

-7 Project Panel [[D3s13s8 | [ ot || D21511 ] [ D18S51 ] E |
- @-[# DRPowerPlex_16 100 150 200 250 300 350 250
L]

£ Panel Templates
@-[# DRPowerPlex_16 3500 ]
=-[& Identifiler '
#-[4 PoweiPlex_16 3,000
#-[# PowerPlex_ESI_16_v1_0
#-[4 PowerPlex_ESI_17_v1_0
ﬂ’ PowerPlex_ESX_16_v1_0_

rm Panel Editor o [ ]
U

Create New Panel .

- [4 PowerPlex_ESX_17_v1_0_
g Profiler_Plus Name: IChimelism Panel Paramoters
@[ SGM_Plus
w7 Test! ) | [™ Fixed Bin Width: IU.S
Q test Type: IHID = | T |
o No. | Type ample Name *i
[Hened 1 Donorl Donor Same
e » " Manually Create | d
roceadaure
E’E S‘amgles sa1 No. " Automatically Create | -~ p
o onar.
& RecpenSor / & UselSanpls eIl would apply to
¢ Use Selected Samples
: i/ Double Donor
5 5 Use Donor and Recipient Sampl = C1€ e Dono : -
= se Donor and Recipient Sample N~ Chlmertyplng
7 (1 (] 2, D1€
3 Panel
9
11 Ok I Cancel «
12 —— =———— — — E—— —
13
14 Penta_E 385.7 05 05 7 1 0.00 Donorl
15 Penta_E 401.0 05 05 10 1 0.00 Recipient - .
= £ See ChimerMarker Manual

Chapter 6



" %CHM Recipient

Chimerism Analysis

Quantification Type——
" Area

{* Height

—Analysis Type

& Wwith Deconvolution

" Without Deconvolution

—Statistical Parameters

—Analysis Threshold

I~ lgnore Locus

Heterozygous Imbalance

Confidence Level [MOE)

|~ lanore Shared Allele Imbalance

—Ermor Threshold

Locus Error
Coefficient of Variation

Measurement Error

Select from the Applications drop-
down menu

Single Donor Chimerism Settings:

% %CHM Type: Calculate by % Recipient or % Donor
(applicable to Double Donor)

“#Ignore Share Allele Imbalance: Ignore markers that
contain unique allele that is greater in intensity or
area than shared allele.

“*Quantification Type: Calculate Chimerism using
Peak Area or Height (applicable to Double Donor)

% Analysis Type:
»*With Deconvolution: Will use unshared allele
information to deconvolute shared peak and
calculate Chimerism

ss*Without Deconvolution: Will ignore locus with
shared peak and only use unshared alleles

“»Statistical Parameters: Parameters to flag locus or
sample using set threshold. (applicable to Double
Donor)




Single Donor Chimerism
Analysis Results

Toolbar

Electropherogram with

Peak Annotations

File Tool

|Ew| = - & 3[8) / 2
et | WAQ QB = B
1 R: patfsa 9043%  937% NAN  No « |
2 D1: donfsa NI NI NI YesfAuto]
3 37 G11 13fsa 81.41%  153% 783% No |patfsa 122.5/2224
2 Mix051 E08 10.fss AMEL NI NI NI Yes(Auto) [ pasizse | | VWA ] [ FGA ]
NS D8511739 NI NI NI Yes{Auto) 100 120 140 160 180 200 220 240 260 280 300 320 340 360
5 Mix:384_E0B_10.fsa D215 8669%  4.85% 1378% No v > ey
6 Mixd32_F11_11.fsa D18551 7811%  553% NAN  No 5,000
7 Mix:558_E01_09.fsa D5S818 78.75%  716% 021%  No 4,000
8 Mix793 G10 14fsa D135317 NI NI NI Yes(Auto) '
NSl D75820 NI NI NI Yes{Auto) 3,000 [l
9 Mix:821_D02_08.fsa 71 o]
1 Mix:866_H09_15.fsa Total D 2,000 -
1 Mix:933_E01_09.fsa Average Chimerism: 82.68% 1,000 J M
1 Mix953 FO5 11.fsa Coefficient of Y ariation: 6.99% 0 I 1’ .
Ny . Dev: 578 ey
1 Mix:333_E06_10.fsa MOE: 718(35%) fig) i3] Izl
Number of Informative Loci: 5 Idon.fsa
[ Dp3s13s8 ] VWA ] [ FGA |
Sample 100 120 140 160 180 200 220 240 260 280 300 320 340 360
. : 1 " o]
name list [ Results Table display &&= o
o o 2,000
statistical as well as
1,000}
calculated chimerism , , ) A
information. T CICE 1
[ FGA ]
100 120 140 160 180 200 220 240 260 280 300 320 340 360
| —wr r e
2,000 (DR [DIR]
1,500 ]
1,000
500.
o_
[16] [1g] [13]

See ChimerMarker Manual
Chapter 2



Double Donor Chimerism
Analysis Results

File Tool
Q@ =]~ - & ofE) 2
No| FileName Marker Name | %Total D CHM | %D1 CHM | %D2CHM | Total LE[ DTLE [ D2LE [Ignored || Wl ~ & & 5 K= || -

1 R: GT_Recipient_28_001_1.fsa
2 D2 0T_Donor2_28_003_1.fsa
3 D1: UT_Donorl_28_005_1.fsa
4 MixR_D2_D1_1ng_1to2to3_28_
5 MixR_D2_D1_1to2to3a_31_007
6 MixR_D2_D1_1to2to3b_31_00¢
7 MixR_D2_D1_1to2to3c_31_011
8 MixR_D2_D1_1to2to3d_31_012
9 MixR_D2_D1_1to2to3e_31_01¢
1 MixR_D2_D1_1to2to3f_28_002

D851179 80.12% 4419%  3593%  030% 519% 1014% No K [
D21511 77.84% 4717%  3066%  314%  121%  600% No o
D75820 75.44% 3977%  3BE7% BA2%  1468% 937%  No |GT_Recipient_28_001_1.fsa
CSFIPO 8753% NAN NAN 892% NAN NAN  No [ DasS1179 |
D351358 86.75% NAN NAN 796%  NAN  NAN  No 120 130 140 150 160 170
THO1 80.21% 5558%  2463%  018%  19.25% 2450% No 6000 —
0135317 78.96% B/IR% 4303%  1.74%  2292% 31.93% No ' Rl @
D165533 74.37% 4427%  3009%  746% 501% 774%  No 4,000
0251338 74.83% 4446%  3037% 688X 461% 689% No 2000 ]
D195433 NI NI NI NI NI NI YesfAuto) o
oy 7919% 51.75%  2743%  146%  11.04% 1530% No 0 s
TPOX 85.97% 60.65%  2532%  B98%  3012% 2237% No
D18551 78.88% 4842%  3046%  184%  388% 6E2% No
BMEL NI NI NI NI ML NI Yesghuo) | OT-Denor2 28,003 1fsa

No

DESENS B1.17% 0% 4368%  101%  1955% 33.90% I D851179 I
FGA 83.77% 49627 315%  425%  G46%  4E3% Mo 120 130 120 150 160 170
TotalD D1 D2 0001 [02] i
Average Chimerism: 80.36% 46.61% 32.62% 20004
Coefficient of Yariation: 5.33% 15.53% 18.88% '
St Dev: 428 724 616
MOE: 247095%)  4B095%) 391(35%) 0 —
Number of Informative Loci: 14 12 12
| UT_Donorl_28_005_1.fsa
[ D851179 ]
120 130 140 150 160 170
*k C C C 20001 IS
Total Donor Chimerism is o0 JL
calculated as well as estimated ' -

R_D2_D1_1ng_1to2to3 28_011_1.fsa

[ D851179 ]
120 130 140 150 160 170

A

D1 and D2 components.
***Locus Error is also calculated E2
individually for D1 and D2 -

=)

See ChimerMarker Manual
Chapter 2



Print or Save Report

Save Report:

File>Save Report

Click on Print Icon é

Print Options for Single Donor:
»Print all Samples or Select Specific Samples
»Print all Markers or Select Specific Markers

»>Print all or only specific parameters.

_Salllpic

" All Samples " Selected Samples _-I

Pearf,
Ferformance

CU:UI'
’7|7 Dyel v Dye2 v Dye3 I~ Dyed

I~ Keep Zoom Region I~ Informative Markers

—Marker
Al Markers

—P.
F

|v Z%Chimerism |v Locus Error

v Measurement Error |V Analysis Comments

| [& Preview I X Cancel I

Print Options for Double Donor:

»>Print all Samples or Select Specific Samples
»>Print all Markers or Select Specific Markers
»>Print all or only specific parameters.

»>Print all Reference components or specific components
only.

»>Keep Zoom Region prints current region of
electropherogram

—Samples

" Al Samples ¢ Selected Samples _I

Pearf,
Ferformance

Color
’,IV Dyel v Dye2 v Dye3 I~ Dyed

I~ Keep Zoom Region I~ Informative Markers

—Marker

Al Markers

P
F

|V %Chimerism ¥ Locus Error

I~ Measurement Error |V Analysis Comments

Paf
reterence

|v Donorl |v Donor2 v Total

[& Preview I X Cancel |




Comprehensive Report

\

A

Chimerism Analysis Report - SoftGenetics Conclusion
Software: ChimerMarker V2.8.1 Analysis Type: Single-Donor Chimers mWih Deconvoluton
Project: Kristt 6-18-2011.SGC Panel: DK_Test CHM
User: Quantification Type: Height
Report Time: 11012011 - 10:10:00 Coefficient of Variation: 10.00% Comments
Chimerism Type: % Donor Chinernsm Locus Error: 10.00%
Confidence Level (MOE): 35% Measurement Error: 2000% Dste Inital
Sam ple Name: 208037 M achine: demo_2100 Authorizason 1
Comments: Run Time: 05/032011- 11:52:15 -> 05/032011 - 12:32:49

Authorizaton 2

037_G11_13.8a

Marker |ME LE CHM Ignored
D251258 |NAN  [2.37% [2042%|Ne
100 120 140 160 320 340 380
" VWA NI NI NI Yes(Auto)
2,000
FGA 723% |1.54% [s141%|No
1.5004 AMEL NI NI NI Yes(Auto) | &——
1.000] DES1179 NI NI NI Yes(Auto)
e 21511 |1278% [4.85% [22E9% Ne
- D18S51 |NAN % [7811% N0
0] psssi8 |021% [7.17% [7875% [Ne
D128317 |NI NI NI Yes(Auto)
Digs51 ] D7S820 (NI NI NI Yes(Auto)

320 340 380

2,000

Average Chimerism: 82.68%
St. Dev: 578

Coefficient of Variance: £.59%
MOE: 7.18 (95%)

Number of Infformative Loci: 5

1500

1,000

500

320 340 380

2,000+
1500
1.000

500

See ChimerMarker Manual
Chapter 2



Long Term Monitoring:
Adding Subsequent Samples

* No need to repeat
analysis - Add Samples to
Project appends the
patient project with
follow-up samples over
time.

Y e . Mix-m-vz-or- a1
7 B Mix R_D2_D1_Tto2to3e_31_01¢

? @ Mix R_D2_D1_Tto2to3f_28_002 5,500-
? B D1:UT_Donar1_28_005_1fsa

7 [ D2 0T Donoi2.28 0031 fsa - To add additional samples to a
7 L[ R:GT_Recipient_28_001_1.fsa saved project:
45001 Project=> Add Samples to Project

See ChimerMarker Manual
Chapter 2



Longitudinal Report

ech_support@softgenetics.com

lﬁ- Longitudinal Report = :—-@ng
File Tool

ga B /O @ = B Fshwd —f [5%

Patient Name: John Doe

Sex: Male

Age: 45

Date of Transplantation: 9/16/2006

John Doe Longitudinal Graph
B %Total D CHN]

110%
Ewo%
S 90%
E
=
5 80%
& 70%
©
S 60%
z
= 50%
E
5 40%
= 30%
=
2
£ 20%
o
10%
0%

No. | Sample Na... |
§21_D02_08
933_E01_09
959_F05_11
558_E01_09
061_E08_10
432_F11_11
793_G10_14
866_H03_15
037_G11_13

0 384 _E0E_10

=00~ W =

240
242
244

11/29/2006
12/06/2006
12/11/2008
11/15/2007
02/09/2009
04/18/2010
04/13/2011
04/21/2011
05/03/2011
05/19/2011

Idenliﬁler‘ CHM Total | SD Total| CV Total

Normal:
Normal:
Normal:
Normal:
Normal:
Normal:
Normal:
Normal:
Normal:
Normal:

[EENEZIN 674
IS5z 2.97
[SEH7ZNN 367
ST 1.06
[SHTEZIN 7.23
[S553Z 3.03
[83807%20 6.28
[E125%0 3.89
[B2I68%0 5.78
ez 4.90

vPatient Name: John Doe

Transplantation Date: 9/16/2006

*Trademarks are the property of their respective owners
Not intended for human or animal diagnostic use

See ChimerMarker Manual
Chapter 2
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